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Section 1: Introduction

The purpose of this manual is to assist users with the installation and operation of the Daktronics
Data Manager (DDM) application. The DDM application is a plug-in for Microsoft® Office Excel® that
converts data from spreadsheets into formats used by Daktronics display control systems. Once the
data entered in a spreadsheet is outputted as Real Time Data (RTD), it can easily be sent to displays.
The manual is divided into four sections: Introduction, Installation, Operation, and Appendix.

e Introduction covers the basic information about the application and this manual. Take time
to read the entire introduction as it explains concepts and conventions used throughout the
rest of the manual.

o Installation describes the installation procedures of the DDM application.

e Operation details the specific operation and configuration of the DDM application.

e Appendix includes an exercise to help users create a basic DDM spreadsheet.

Daktronics identifies manuals by an ED or DD number located on the cover page of each
manual. Any manuals referenced in this document will be identified by its ED or DD number.
For example, this manual would be referred to as DD1376354.

1.1 System Requirements

The DDM application has the following system requirements:
¢  Windows XP or higher Operating System
e Microsoft® Excel® 2003 Professional or better
e CPU and RAM must at least be equal to minimum requirements of operating system
e Additional serial ports or networking may be needed based on interface requirements

The DDM application will typically be loaded onto a computer system that already contains

other Daktronics software, such as the Daktronics display controllers; however, it may also be
installed on a different computer on the same network.

1.2 Software Conventions

This manual contains the following software conventions and terminology:

Bold Indicates an item that requires direct action, such as clicking, pressing,
selecting or formatting.

Italics Indicates onscreen text or labels that are not clickable.

Bold Italics Used to reference items within the manual, such as figures or sections, as
well as other documents and important notes.

[X] Represents a keyboard key that needs to be pressed.

“Quotes” Text or commands that may be typed; also indicate file or folder names

Click Press and release the left mouse button.

Double-click Press and release the left mouse button twice.

Right-click Press and release the right mouse button.

Select Highlight or mark, such as by placing a check mark v in a nearby box;
clicking will not necessarily perform an action.

> Followed by, as in menu navigation (ex. File > Open).

Introduction 1






Section 2: Installation & Registration

2.1 Installation

To install the DDM application:

1.

G LN

Download and save the “DDM.zip” file from

http:/ /dakfiles.daktronics.com/downloads/Sports_Products/DDM/.
Extract the contents of the “DDM.zip” file.

Double-click the “setup” file to begin the installation procedure.
Follow the onscreen instructions.

Click Close when done.

2.2 Opening & Exiting the Application

To open the application:

1.

2.
3.

4.

Navigate to “C:\ Program Files\ Daktronics\ DDM” (Windows XP) or
“C:\Program Files (x86)\ Daktronics\DDM” (Windows 7 +).

Copy the “DDM.xIs” Excel Worksheet file.

Create a new folder in a different location, such as the “Desktop” or “My
Documents”, and Paste the “DDM.xIs” Excel Worksheet file into the new folder.
Double-click the “DDM.xIs” Excel Worksheet file inside the new folder.

Note: It is possible to open the DDM worksheet right from the “Program Files” folder.
However, going through the above process will prevent the original DDM worksheet
from being overwritten, and a clean copy will always be available to make new
worksheets later on.

To exit the application:

Click the top exit button in the upper-right corner of the window to close the Excel
application completely.

Click the bottom exit button in the upper-right corner to close only the DDM
spreadsheet.

Hold [Alt] and press [F4].

2.3 Registration

When the DDM application is first opened, the registration screen will appear (Figure 1).
A new software license file must be obtained using the given Lock Code.

Lock Code: 0x26BCO

Figure 1: Registration Window

LoadLicense...
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The registration process varies depending on the operating system in use:

Windows XP
1. Open a DDM spreadsheet as described in Section 2.2.
2.  Write down the Lock Code, and exit the DDM spreadsheet.
3. Email the Lock Code to DakStats@daktronics.com with the subject line “DDM Lock
Code”, and a software license file will be emailed back upon proof of purchase.
4. Save the software license file to “C:\ Program Files\ Daktronics\DDM".
5. Reopen the DDM spreadsheet. The license file will load automatically and unlock the

application for use.

Windows 7 +

1.

2.

Set Excel to Run as administrator by right-clicking the “EXCEL.exe” file located in
“C:\Program Files (x86)\ Microsoft Office\ Office##".

From within Excel, press [Ctrl] + [O] and navigate to the “DDM.xIs” file to open.
The default location is in “C:\ Program Files (x86)\ Daktronics\ DDM”; however, it is
recommended that a backup copy first be saved elsewhere.

Write down the Lock Code, and exit the DDM spreadsheet.

Email the Lock Code to DakStats@daktronics.com with the subject line “DDM Lock
Code”, and a software license file will be emailed back upon proof of purchase.
Save the software license file to “C:\ Program Files (x86)\ Daktronics\ DDM".
Reopen the DDM spreadsheet, and the license file will load automatically to unlock
the application for use.

Close out of Excel. It should now be possible to double-click a DDM spreadsheet to
open it without having to run Excel as an administrator.

Note: The DDM application will not become functional without a software license. If the
DDM application is not registered, be sure to close the DDM spreadsheet, or it will not be
possible to open any other spreadsheets.

Installation
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Section 3: Operation

The operation of the DDM application depends largely on the user’s familiarity with Microsoft Excel.
For assistance using Microsoft Excel, please refer to the Microsoft Office Excel Help by pressing [F1].
With a little practice, it will be possible to output data to a display as easily as using ordinary
Microsoft Excel spreadsheets.

This section of the manual on program operation is broken into three main sections:
e The Main Application Screen
¢ Document Actions Task Pane
e Advanced Data Importing

3.1 Main Application Screen

After the DDM application is registered, the main application screen will appear (Figure 2).
This screen contains all the menus and buttons as a typical Excel spreadsheet. Every setting
related to outputting information to a display is found in the Document Actions task pane.

r 7_] = =10 DDM [Compatibility Mode] - Microsoft Excel - B2 X
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Figure 2: DDM Main Application Screen (Excel 2007)
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By default, there are six cells of the spreadsheet highlighted in blue. Any data entered outside
of the highlighted columns will not be included as Real Time Data (RTD). The extra space
may be used for labels or notes about what data should be included in the spreadsheet.
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3.2 Document Actions Task Pane

The Document Actions task pane (Figure 3) displays all the settings to output RTD from the
information that was typed or imported into the spreadsheet.

Document Actions v X

DDM Eg:=7es"

view | Fd ¥ B m | Hep
El General
Columns (Array)
DataRangelocation 5 2
HighlightCalor [] skyBlue
InputMapping Package Mapping Collection
RowCount -1

Figure 3: Document Actions

Enabling Document Actions

The Document Actions task pane is opened by Lview | View | Acrobat
default. If the task pane is closed, go to View > —
Document Actions to turn it back on in newer 31 ' -_" i E \J
versions of Microsoft Excel (Figure 4) - -
8 ’ Document( Zoom 100% Zoomto
Actions selection
Note: For Microsoft Excel 2003, go to View > Zoom

Toolbars > Task Pane (Figure 5). It may also
be necessary to click the down arrow on the
Task Pane, and then select Document Actions

Document Actions

Open the Document Actions Task

(F A 6) Pane,
1gure 6). - - -
Figure 4: Enabling Document Actions
Wiew | Insert Format  Tools Data  Team  window :l -
Hormal Eay @ - F |9 - : |IDocument Actions hd
- W| Refresh 'Conflgure List | | G’:’ l ﬂ l ﬁ GEtting Started
Task Pane Chrl4+-F1 Fp— HE||:I
| Toolbars 3 | '7‘ Standard DDM CENTE
Zoom... e Search Results
Borders C|i|:l Ak
Chart R h
Cantrol Toalbox Wiem | E‘j _H? ﬂ BSEarc
Dirawi Clipboard
ErfW'nng . E General 2
xrernal ara
. Columns Mews Workbook,
arms
Formula Auditing Ejﬁtljlp\:l:ge:_ﬂtatlﬂn TEIT||:I|E||ZE HE||:|
ighlightColor
List a
ot InputiMapping Dacument Actions
PivatTable R Zounk Shared Warkspace
petecton Docurnent Updates
Reviewing
Task Pane *ML Source

Figure 5: Enabling the Task Pane Figure 6: Enabling Document Actions
(Excel 2003) (Excel 2003)
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The Document Actions task pane contains the following six buttons:

view | F ¥ m | Help
2) 3) 4 5)

1) 6)

1) View

2) Package Suite Editor

3) Port Configuration

4) Function Button Configuration
5) ITF Configuration

6) Help

In addition to buttons, the Document Actions task pane also includes five configuration boxes:

e Columns

e Data Range Location
¢ Highlight Color

¢ Input Mapping

¢ Row Count

View

Click the View button (Figure 7) Toolbars  » | v | Input Monitor

]

to enable or disable the Input and

Output Monitor toolbars (see View F j E Output Monitor

Input & Output Monitors). Figure 7: View Button

Package Suite Editor

Click the Package Suite Editor button to open a window to import packages of data into

the spreadsheet from an external data source (see Advanced Data Importing).

Port Configuration

Click the Port Configuration button to open a window to set up ports for sending or

receiving data (Figure §8).

,_? Port Configuration @
This screen allows you to add, remove, and configure a port, which represents a data transportation hub
for data inputting (RX) or outputting (TX).

Ports Properties
New Port 1 E General
Format ERTD
Name New Port 1
Protocol None
Suite
Type T
Name
The port name
Add ] [ Remove
Ok | [ Cancel |

Figure 8: Port Configuration Window
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1. Click Add to insert a new port.

2. Under the General header, adjust the following options to set up the new port:
e Format: Set to ERTD for outputting data to Daktronics displays.
e Name: Type in a descriptive name for the port.
e Protocol: Select the method of data transfer from Serial, Tcp, or Udp.

Note: Additional settings will appear based on the chosen connection.
Contact the network administrator to apply the appropriate settings.

e Suite: Assign a package suite if applicable (see Advanced Data Importing).
e Type: Select Tx if the port will be used to send out data or Rx if the port will
be receiving data.

3. Click Ok when finished.

Function Button Configuration

Click the Function Button Configuration button to open a window to set up buttons for
starting and stopping data output as well as advanced display control commands (Figure 9).

Note: Each DDM spreadsheet file has a corresponding “DDM.cfg” configuration file located
in the same directory. If a directory has multiple spreadsheet files, they will read from the
same configuration file and share the same buttons. It is recommended to keep each DDM
spreadsheet file in its own folder to prevent function buttons from being overwritten.

Function Button Configuration @

In DDM, each worksheet has a designated toolbar, on which you can put a series function buttons. You can define
a list of commands (a script) for each button to run when the button is clicked.

Select the worksheet to configure keys: Froperties:
DOM - Range 1 - E Misc
) Name Key 1
Buters: TR Command Collection ()
Key 1
Script
The script is a list of cutputting commands.

[ Import H Add H Remaove ]

Ok || Cancel

Figure 9: Function Button Configuration Window
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Creating Function Buttons

1. On the Function Button Configuration window, select a worksheet (Range) for which
the buttons will be used.

2. Click Add to insert a new function button.

3. Click Command Collection, and then click the (=) button to open the Script Editor window.

4. Click Add to insert a new command.

5. Under Type, click the arrow to choose from a list of command types (Figure 10).
Multiple command types may be assigned to a single button as long as the actions do
not negate each other.

“HA Script Editor % | =]

In DOM, you can associate a series commands (like starting 3 sequence and selecting a frame, efc) with 2
button click. This screen guides you to create a list commands (the script) for the defined functine button..

Commands Properties
Command 1 'S El General
None [+l
BlankSign "
SignDimming
SelectFrame
EndSchedule
StartSequence
Start Schedule A
Capture Rtd 3
None
Paging
Scrolling
(Grouping
Type StopAutoSending
Select & proper cOMMa| R freshData i
[ Add ] [ Remove ] S -

Figure 10: Script Editor Window

6. Select StopAutoSending, and then click Ok.
7. Change the Name of the function button to “Stop”.

Note: Every DDM spreadsheet file must include a button to stop sending data and one or
more buttons to resume sending data. Other display controls may be configured as needed.

Paging Function Buttons
Paging function buttons send out pages of RTD with a predefined number of rows of
information on each page.

1. Repeat steps 1 - 5 under Creating Function Buttons.
2. Select Paging from the list of command types.
3. Adjust the following settings accordingly:
e HoldingTime: Type in how many seconds to wait before sending the next data set.
e Port: Select a previously configured port (see Port Configuration).
e RecordCount: Type in how many rows of data should be sent out at a time.
e Sorts: Sort text or numerical data in ascending or descending order before it is
sent out (See Sorting).

4. Click Ok when finished.
5. Give the Paging function button a descriptive Name.

Note: Both Paging and Scrolling will send out data until the first empty row of data, and
then start from the top again. To allow blank rows to be sent, there must be at least one
cell in that row with a dummy character (such as a space) in order for it to appear to be
empty. Otherwise when the DDM application finds a row with absolutely no data, it will
disregard any information following the empty row.

Operation 9



Scrolling Function Buttons
Scrolling function buttons send out RTD line by line with the next piece of data moving into
the previous spot until all of the information has gone through.

1. Repeat steps 1 - 5 under Creating Function Buttons.
2. Select Scrolling from the list of command types.
3. Adjust the following settings accordingly:
e HoldingTime: Type in how many seconds to wait before sending the next data set.
e  Port: Select a previously configured port (see Port Configuration).
e RecordCount: Type in how many rows of data should be sent out at a time.
e Sorts: Sort text or numerical data in ascending or descending order before it is
sent out (See Sorting).
4. Click Ok when finished.
5. Give the Scrolling function button a descriptive Name.

Sorting SR Sot Seting
When creating Paging and Scrolling function FirstSort
buttons, users are given the option to sort the data FirstSortOrder  None
before it is sent out (Figure 11). Sorting ensures that SecondSort
data will always be displayed in a specific way, SecondSortOrder None
regardless of how it appears in the spreadsheet. ThirdSort

. . ThirdSortOrder  None

e First/Second/ThirdSort: Select the header

name of the column that includes the data  Figure 11: Sorting
that will be used as the criteria for sorting.
e First/Second/ThirdSortOrder: Select Ascending (Asc) or Descending (Desc) sort orders.

Up to three columns can be used to determine how data is sorted. This is useful in cases of
duplicate information in a column. For example, if two people have the same last name in a
column of names that are sorted alphabetically (FirstSort), then a column with their first
names could be used to determine the next sort order (SecondSort).

Grouping Function Buttons
Grouping function buttons send out multiple rows of data based on the first selected row.

1. Repeat steps 1 - 5 under Creating Function Buttons.
2. Select Grouping from the list of command types.
3. Adjust the following settings accordingly:
e Port: Select a previously configured port (see Port Configuration).
e RecordCount: Type in how many rows of data should be sent out at a time.
4. Click Ok when finished.
5. Give the Grouping function button a descriptive Name.

Select Current Function Buttons

A Select Current function button allows users to select a row that will always be visible
even if it is not due up to be displayed in the main scrolling, paging, or grouping order.
The Select Current function button is also used to choose a location to import data

(see Advanced Data Importing).

Repeat steps 1 - 5 under Creating Function Buttons.

Select SelectCurrent from the list of command types.

Click Ok when finished.

Give the Select Current function button a descriptive Name.

LN
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Note: The buttons on the following two page are optional commands for the display controllers.
These buttons are not needed to output data from the DDM application.

Start Sequence Function Buttons

Start Sequence function buttons start sequences on selected signs. Sequences (Presentations)
control the arrangement and appearance of graphics and data on a display. Refer to the
documentation provided with the Daktronics display control software for more information
on creating sequences.

1.
2.
3.

4.
5.

Repeat steps 1 - 5 under Creating Function Buttons.

Select StartSequence from the list of command types.

Adjust the following settings accordingly:

e Mode: Select from Continuous, SingleStep, or SelectedFrame play modes.

e  Port: Select a previously configured port (see Port Configuration).

e Sequence: Type in the Drive letter, Frame number, Library name, and Sequence
name for the sequence to start.

o  SignNumber: Type in the sign number for the sign on which the selected sequence
should be started.

o Times: Select the number of times to display the sequence.

Click Ok when finished.
Give the Start Sequence function button a descriptive Name.

Blank Sign Function Buttons
Blank Sign function buttons clear the data from selected signs.

1.
2.
3.

4.
5.

Repeat steps 1 - 5 under Creating Function Buttons.

Select BlankSign from the list of command types.

Adjust the following settings accordingly:

e Port: Select a previously configured port (see Port Configuration).
e SignNumber: Type in the sign number for the sign to be blanked.
Click Ok when finished.

Give the Blank Sign function button a descriptive Name.

Start Schedule Function Buttons
Start Schedule function buttons start schedules on selected signs. Refer to the documentation
provided with the Daktronics display control software for more information on creating schedules.

1.
2.
3.

Repeat steps 1 - 5 under Creating Function Buttons.

Select StartSchedule from the list of command types.

Adjust the following settings accordingly:

e Port: Select a previously configured port (see Port Configuration).

e Schedule: Type in the Drive letter, Frame number, Library name, and Sequence name
for the schedule to start.

o SignNumber: Type in the sign number for the sign on which the selected schedule
should be started.

Click Ok when finished.

Give the Start Schedule function button a descriptive Name.

Operation
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End Schedule Function Buttons
End Schedule function buttons stop schedules from running on a sign.

1. Repeat steps 1 - 5 under Creating Function Buttons.
2. Select EndSchedule from the list of command types.
3. Adjust the following settings accordingly:
e  Port: Select a previously configured port (see Port Configuration).
e SignNumber: Type in the sign number for the sign that should stop running
schedules.
4. Click Ok when finished.
5. Give the End Schedule function button a descriptive Narme.

Sign Dimming Function Buttons

Sign Dimming function buttons control the brightness levels of selected signs. Refer to the
documentation provided with the Daktronics display control software for more information
on dimming controls.

1. Repeat steps 1 - 5 under Creating Function Buttons.
2. Select SignDimming from the list of command types.
3. Adjust the following settings accordingly:
e Dimming: Select from ManualDim, ManualBright, PhotocellDetect,
PhotocellRemote, or ScheduleDimming,.
e  Port: Select a previously configured port (see Port Configuration).
e  SignNumber: Type in the sign number for the sign to have dimming control.
4. Click Ok when finished.
5. Give the Sign Dimming function button a descriptive Narme.

Refresh Data Function Buttons
Refresh Data function buttons resend data before the hold time has passed.

Repeat steps 1 - 5 under Creating Function Buttons.
Select RefreshData from the list of command types.
Click Ok when finished.

Give the Refresh function button a descriptive Name.

RN

Select Frame Function Buttons
Select frame function buttons play only a selected frame within a currently playing sequence.

1. Repeat steps 1 - 5 under Creating Function Buttons.
2. Select SelectFrame from the list of command types.
3. Adjust the following settings accordingly:
e FrameNumber: Type in the number of the frame to play in the current sequence.
e Port: Select a previously configured port (see Port Configuration).
o SignNumber: Type in the sign number for the sign that contains the selected frame.

4. Click Ok when finished.
5. Give the Select Frame function button a descriptive Name.

Capture RTD Function Buttons

Capture RTD function buttons are used primarily for in-house testing purposes. These
function buttons store the current frame buffer data into a secondary capture buffer that can
be recalled at a later time.

12
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ITF Configuration

Click the ITF Configuration button to open a window to set up an Input Template File

(Figure 12). An ITF is the link between the display controller and the information that is
entered in the spreadsheet.

@ Itf Configuration @

This screen will guide you to create an ITF file for you selected worksheet. The ITF
is generated based on the DOM settings of the selected worksheet.

Data Stream -

0K ][ Cancel

Figure 12: ITF Configuration

Select a Data Stream (worksheet).

Click OK.

Save the ITF with a descriptive name.

The ITF will then be used by the display controller to gather RTD from the
spreadsheet.

LN =

Note: An ITF must be saved before data can be sent to a display controller and after the
following actions are performed:

¢ Adding or removing Headers

e Modifying the Size of a data field

e Modifying the Title of a data field

¢ Adding, removing, or modifying function buttons

Help
Click the Help button to see information about the version of the DDM application that is
currently installed and to open the instruction manual (Figure 13).

Instructions "
About

Help

Figure 13: Help Button

Operation
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Columns

This configuration box sets the number of highlighted columns in the data field, as well as the
maximum number of characters for each piece of data in the column. Click the plus (+) and
minus (-) signs to expand or hide the options, respectively.

1. Click Columns, and then click the () button that appears to open the Header Editor
window (Figure 14).
2. Click Add to insert more columns, and click Remove to delete columns.

o= Header Editor EI@
Header List Properties
Header 1 = General
Header2 X 25
Header 3 .
Header 4 Tile
Header 5
Header &
Size
‘when outputting data, each data field has a
[ Add ] [ Remove ] fixed size, so each field has a predictable loca..
Ok | [ Cancel

Figure 14: Header Editor Window

3. Select a maximum Size in characters for the information in each cell for the column.

Note: If information appears to be getting cut off on the display, make sure that the
Size is large enough to fit the whole piece of information. Resizing column width to
see longer information is not the same as changing the Size.

4. Enter a Title for the column. The Title will show up as the column header in the RTD.
5. Click Ok when finished.

Data Range Location

This configuration box sets the starting location of the headers on the spreadsheet (Figure 15).
Click the plus (+) and minus (-) signs to expand or hide the options, respectively. Be sure to
adjust this setting before entering data into the spreadsheet cells.

=) DataRangelocation g, 2
ColumnIndex 2
RowIndex 5

Figure 15: Data Range Location
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Highlight Color

This configuration box is used to change the color of column
headers. Click HighlightColor, and then click the arrow to select
from a wide variety of preset colors (Figure 16).

Note: Changing the highlight color, text colors, and text

sizes or fonts will not affect their appearance on the display.

Input Mapping

This configuration box is used to define what input package
fields are to be displayed in which cells of the spreadsheet. See
Advanced Data Importing for more information about package
suites and input mapping.

Row Count

HighlightColor | NG

=

I Teal

I DarkCyan
[ Cyan

[ Aqua

[ LightCyan
[ Azure

1 DarkTurquoise
I CadetBlue
[ PowderBlue
[ LightBlue
[ DeepSkyBlue
I ckyBlue
[ LightSkyBlue
I SteelRlue

Web | system

Figure 16: Highlight Color

This configuration box is used to define the total number of rows in a column, not counting
the header. If the final number of rows in a column is unknown, leave the Row Count value
set to “~-1” and the first empty row will be used to determine the actual row count.

Input & Output Monitors

The bottom of the Document Actions task pane displays both an Input Monitor and an Output

Monitor (Figure 17). These toolbars are used to detect problems in receiving or sending data.

Each toolbar shows the port that data is traveling through, the last time the data was sent or

received, and the data itself.

g ? x|

Port:

Timestamp:

Output Monitor | Input Monitor
Figure 17: Input & Output Monitors

The toolbars can be rearranged or removed entirely:

e C(lick the Toggle Tabs button to view both monitors side by side.

e  C(Click the Auto Hide button to minimize one or both monitors.

. x .

e  (Click the Close button to remove one or both monitors from the Document
Actions task pane. Use the View button to bring them back.

e (Click and drag the monitor toolbars to move them anywhere on the screen.

Note: For newer versions of Excel, the data monitor window may have a black background
with black text, so it appears as if nothing is outputting. To confirm that data is in fact being

sent out, click and drag on the text in this box.

Operation
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3.3

Outputting Data

After function buttons have been created, a new tab called Add-Ins will appear at the top of
the screen in newer versions of Microsoft Excel (Figure 18). Use this tab to access all of the
available function buttons.

Home Insert Page Layout Farmulas Data Review View Add-Ins

stop Paging 5crolling Scrolling with Sorting

Custom Toolbars

Figure 18: Function Buttons Toolbar (Add-Ins Tab)

Note: In Microsoft Excel 2003, the
buttons will be in the bottom left Stop Scroling Paging by 5 Paging by 10 E
corner of the screen (Figure 19). If the
buttons do not appear at first, re-open
the Function Button Configuration

Ready
Figure 19: Function Button Toolbar (Excel 2003)

screen, and click OK.

1.

2.

Enter data into the spreadsheet as normal. Be sure to utilize the formulas and
features available in Microsoft Excel for creating spreadsheets.
When it is time to output the data:

Click a Paging or Scrolling function button to begin continually sending out
information across the port assigned to the button. The worksheet tab will turn
from red to flashing green, and data will appear in the Output Monitor.

M DDM ¥

Click the Select Current button to highlight a selected row in gray. The current
row data will only be sent out if the rest of the data is already Paging or Scrolling.
If there is no data in a selected row, the current row fields will be left blank. The
worksheet tab will remain red after the button is clicked by itself, or it will
remain green if a Scrolling or Paging button was clicked first.

Click a Grouping function button to send out information across the assigned
port only if valid data has been selected. Grouping buttons can be clicked
independently or while data is still Scrolling or Paging. The worksheet tab will
remain red after the button is clicked by itself, or it will remain green if a
Scrolling or Paging button was clicked first.

Click the StopAutoSending function button to stop sending out information. The
worksheet tab will become red again.

M| DDM ¥

Note: It is not necessary to stop sending out data to modify it. Simply type in the changes
on-the-fly and they will appear in the next data cycle.
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3.4 Advanced Data Importing

Packages

Packages tell the DDM application what types of incoming data to look out for, similar to
what an ITF does for the display controller. Incoming data sources will typically include other
Daktronics products, such as an All Sport® controller, for scoring and timing information.

In order to utilize packages for importing data, there are three major steps to complete:
1. Create a Package Suite

2. Create an Input Port

3. Input Mapping

Create a Package Suite

1. Click the Package Suite Editor button .
2. Click Add to insert a new package suite (Figure 20).

i Package Suite Editor @

Aninput data source may deliver one or more types of packages. A package suite is a place holder
of the formats of all possible different packages from an input data source.

Package Suites Properties
New Suite 1 E General
Mame New Suite 1
= Package Collection.. [..]
= [0 Package [1]
Fields Field Collection...
Import
Mame Package 1
Type Ascii
Packages
An input data source may deliver multiple types of

[ Add ] [ Remove ] packages. This is the list of the package types inthe 5.

Ok | [ Cancel

Figure 20: Package Suite Editor Window

3. Type a descriptive Name for the package suite.

Leave Type set to Ascii.

5. Click Package Collection, and then click the [..J button to open the PackageSetting
Collection Editor window (Figure 21).

=

PackageSetting Collection Editor @
Members Package 1 properties:
(] Package 1 + i,\i |
I B Misc
Fields Field Collection .
Import
Mame Package 1
Add ] [ Remove

Figure 21: PackageSetting Collection Editor Window
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a. Click Add to insert a new package to the package suite.
b. Type in a descriptive Name for the package.
c¢. Import an ITF, or manually create the data fields:

Import Fields
1) Click Import and then click the L...] button to locate and Open an ITF.
A list of Fields will automatically be populated based on the ITF.
2) Click OK to return to the Package Suite Editor window (Figure 20).

Create Fields

1) Click Field Collection and then click the (] button to open the

PackageFieldSetting Collection Editor window.

2) Click Add to insert a new field to the package (Figure 22).

PackageFieldSetting Collection Editor

Members:
oo [N
+
Add ] ’ Bemove

(-5l
() properties:
541 |
E Mise
Mask
Name
[ ok |[ canca |

Figure 22: PackageFieldSetting Collection Editor Window

3) Inthe Mask cell, type in one or more of the following symbols to
represent each character of the expected incoming data:

Use an asterisk (*) for any number or letter.

Use a pound sign (#) for a number from 0-9 only.
Use a question mark (?) for a letter only.

To use one of the above characters or other special characters instead
of a number or letter, place a quote (“) before the character.

Note: The first Field should contain definite letters or numbers that
uniquely identify the data as the start of a new incoming packet.

4) Type in a descriptive Name for the field.
5) Add as many fields as needed to receive every piece of desired data.
6) Click OK twice to return to the Package Suite Editor window (Figure 20).

6. On the Package Suite Editor window, it is possible to view and modify the current
package and field settings using the plus (+) and minus (-) signs.
7. Click Ok when finished.

18
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Create an Input Port

1. Click the Port Configuration button .
2. Click Add to insert a new port.
3. Adjust the following options to set up an input port:

Format: Select ERTD if using an imported ITF. Select CUSTOM if the fields were
created manually.

Name: Type in a descriptive name for the port

Protocol: Select the method of data transfer from Serial, Tcp, or Udp.

Note: Additional settings will appear based on the chosen connection.
Contact the network administrator to apply the appropriate settings.

Suite: Select a package suite.
Type: Select Rx.

4. Click Ok when finished.

Input Mapping
1.

Click Ii?putMaEEmg, and I Data Mapping Edtor e
then CIICk the I&I bUtton to To map data of an input package to a row on the current worksheet, add a Package Mapping item first.
Open the Datﬂ Mﬂpplﬂg Then set up the mappings between a desired data field of the package to a column on the current workshee:
Editor WlndOW Package Mapping List Properties
2. Click Add to insert a new &l Mapping
. . B Mappings {Aray)
Package Mapping List B [
. Field
(F lgure 23) Key False
3. Select a Package. -
ackage
4. Select a Type: Type Ovenwiting
e Overwriting: Used only
with a Select Current o

button. Imported data
will be populated in a
selected row. Make [T
sure the previous row
also contains data.

Mapping: Rows will be
populated with data from the input package based on a predefined Key.

Add | | Remove |

Figure 23: Data Mapping Editor Window

5. Click the plus sign (+) next to Mappings to see a list of each column in the
spreadsheet.
6. Click the plus sign (+) next to the column number.

Field: Select a data field from the chosen package that will go in the column.

Key: Used only for Mapping. When a field key is set to True, the DDM application
will not create another row out of the incoming data, but will instead update the
other cells in the row containing data that matches the incoming data’s key fields.

7. Click Ok when finished.

Final Note on Package Suites
If the package suites do not seem to be working correctly, contact Daktronics to create custom
configuration files to suit the particular data importing needs.

Operation
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Web Queries

It is possible to output information to a display that was retrieved from the Internet by using
a built-in feature of Microsoft Excel called a Web Query. This feature is useful for displaying
news stories, stock quotes, out-of-town scores, and many other types of information that are
frequently updated over the Internet. For more information about web queries, please refer to
the Microsoft Office Excel Help by pressing [F1].

1. Select the cell(s) where the imported e ———
information will go.
2. Innewer versions of Microsoft Excel, 5 L g 2 ﬂ () Conneat
. . @ == = =1 7] [
click the Data tab’ and then click From @ From From Other Existing Refresh
From Web (Figure 24). Web | Text Sources  Connections | All-
Get External Data Connedtions
Note: In Microsoft Excel 2003, go to Figure 24: Import Data From Web
Data > Import Exter'nal Data > — T
New Web Query (Figure 25). 3]l sor. TN o
: : Gile ' Links and Attachments
3. The New Web Query window will o R -
appear, which acts as a web Sfiele. ; | i
browser inside Microsoft Excel. Vaidation...
Type in or Paste the address to the Table...
site where the data will be gathered. Text to Colurns. .
4. Once at the desired webpage, click a Copsolidate. .
yellow arrow [*| and it will change Group and Outline v
to a green check mark . Data i3] FivotTable and FivotChart Report...
within the blue highlighted area will Import External Data | B mportpsta...
be imported into the spreadsheet. List * [B meweb query...
EML Y|4 Mew Database Query...
Note: When gathering data from the et Bz I Ecit Query...
Internet, itis Very important to T4 Data Range Properties. ..
identify the source of the gl Parameters...
information to avoid plagiarism and Figure 25: New Web Query (Excel 2003)
violating copyright laws. When in
doubt, contact the author to ask for permission to use the data. Be sure to include the
author of the information on the display if it is someone other than the software user.
5. Click Import.
6. On the Import Data window, select the cell destination for the imported data if needed.
7. Click the Properties button to adjust the settings of the imported data, in particular the
Refresh control (Figure 26).
Refresh contral
| Enable badground refresh
7| Refresh every |5 = minutes
Refresh data when opening the file
Remove external data from worksheet before dosing
Figure 26: Refresh Control
8. When the import properties and location are correct, click OK. Depending on the size of
the data table, it may take a few moments to import the data into the spreadsheet.
9. Be sure to update the number and size of the Columns to match the imported data, and

then save the ITF.
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Appendix A: Sample DDM Exercise

The following exercise will explain how to create a spreadsheet that contains a basic table of first and
last names and output the information as Real Time Data. This exercise is designed to familiarize
users with each step needed to output data from a spreadsheet.

At the end of the exercise, the DDM application will look similar to the following screen:

D =, e | I DDM [Compatibility Mode] - Microsoft Excel - = X
—/ Home Insert Page Layout Formulas Data Review View Add-Ins @ - = x
Stop Paging Scrolling Scrolling with Sorting
Custom Toolbars
B16 - |
A B C D = = G H ? Document Actions ¥ X
1 -
MESSAGE
2 DAKTRONICS DATA MANAGER DDM CENMTER
3
4
5 First Name Last Name
i dEh
6 Carl Johnson vew | [ j m | Help
7 Dave Smith B General
8 Sally Jones Columns (Array)
9 Heather Miller DataRangelocat 5, 2
10 Joe Grant HighlightColor ] SkyBlue
11 Stan Walker Inputtapping  Package Mapping Cc
12 Beth Thompson RawCount -1
13 Steve. Equ D.KS _| | columns
14 Sheri Phillips | | DDM warks with a Data Range consisti...
15 Am Phillips
17 : = J
18
19 Port: udp:f{255,255,255,255;
20 Timestamp:  6/5/2008 2:35:02 PM
g; First Mame Last Mame
23 Stan " alker
24 Beth Thompszon
25 Steve Brooks
Sheri Phillipz
26 Amy Fhillips
27 L4}
28
29
30 ¥ || Input Monitor | Output Manitor
4 4 » M| _DDM ¥ 0L I 0
Ready [EEEr e U (CIE

This exercise is broken into five main sections:
e Creating Headers
¢ Creating an Output Port
¢  Creating Function Buttons
e  Creating the ITF
e Entering & Sending Data
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Creating Headers

1.

2.

Click Columns in the Document Actions task pane, and then click the (J button.

In the Header Editor window, click Remove to delete Headers 3-6, so only Header 1 and Header

2 remain.

o Header Editor

Header List

Header 1
Header 2

Remaove

=5 [E=R )

Properties
E General

25

Title
Size
‘when outputting data, each data field has a
fixed size, so each field has a predictable loca..

[ o ][ cancel |

In the Title for Header 1, type in “First Name” and in the Title for Header 2, type in “Last
Name”. Leave the Size set to “25”, and then click Ok.

Header List Properties
Header 1 Bl General
Header Size a5

AR First Name
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Creating an Output Port

1. On the Document Actions task pane, click the Port Configuration button to open a
window to set up a port for transmitting data.

2. In the Port Configuration window, click Add to insert a new port, and then set up in the
following settings:

e  Format: Leave this option set to ERTD.

e Name: Type in “Output Port”.

e Protocol: For this example, choose Udp.

e Suite: Leave this option blank

e Type: Leave this option set to Tx for transmitting data.
e  Port: For this example, type in “21000”.

Note: When setting up a port, contact the network administrator to make sure these
settings are correct and do not interfere with the data ports of other Daktronics programs.

,_Si Port Configuration @
This screen allows you to add, remove, and configure a port, which represents a data transportation hub
for data inputting (F2x) or outputting (T).

Ports Properties
Output Port EH General
Format ERTD
Name Output Port
Protocol Udp
Suite
Type T
E UDP Settings
Port 21000
Port
The UDP port number
Add ] [ Remaove
Ok || Cancel

3. Click Ok when finished.
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Creating Function Buttons

' : . N . ik
On the Document Actions task pane, click the Function Button Configuration button to opena
window to set up the buttons for starting and stopping data output.

Stop Button
1. In the Function Button Configuration window, click Add to insert a new button.
2. Click Script, and then click the (-] button to open the Script Editor window.

3. Inthe Script Editor window, click Add to insert a new command. Click Type, and then use the
drop-down arrow to select StopAutoSending.

Commands Properties
Command 1 + E General
StopAutoSending [« |

4. Click Ok when finished, and then change the Name of the function button to “Stop”.

Paging Button
1. In the Function Button Configuration window, click Add to insert another function button.
2. Click Script, and then click the -] button to open the Script Editor window.

3. In the Script Editor window, click Add to insert a new command. Click Type, and then use the
drop-down arrow to select Paging.

4. Apply the following settings:
e HoldingTime: Type in “2” to wait two seconds between sending the next data set.
e Port: Select Output Port-Udp, 21000.

RecordCount: Type in “5” to send out five rows of data at one time.

Sorts: Leave this setting empty for now.

Commands Properties
Command 1 + B General
Type Paging
Bl Misc
HoldingTime 2
Port Quiput Port-Udp. 21000
RecordCount 5
Sort Setting

5. Click Ok when finished.

6. Name the function button “Paging”.
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Scrolling Button

1.

2.

5.

In the Function Button Configuration window, click Add to insert another function button.

Click Script, and then click the [-..) button to open the Script Editor window.

In the Script Editor window, click Add to insert a new command. Click Type, and then use the
drop-down arrow to select Scrolling.

Apply the following settings:

HoldingTime: Type in “1” to wait one second between sending the next data set.
Port: Select Output Port-Udp, 21000.

RecordCount: Type in “10” to send out the first ten rows of data each time.
Sorts: Leave this setting empty for now.

Commands Properties
Command 1 T E General
Type Scrolling
E Misc
HoldingTime 1
Port Output Port-Udp. 21000
RecordCount 10
= ESEN sort Setting
Click Ok when finished.

6. Name the function button “Scrolling”.

Scrolling Button with Sorting

This example will only create a Scrolling button with sorting, but Paging buttons may be configured
with sorting as well.

1.

2.

In the Function Button Configuration window, click Add to insert another function button.

Click Script, and then click the () button to open the Script Editor window.

In the Script Editor window, click Add to insert a new command. Click Type, and then use the
drop-down arrow to select Scrolling.

Apply the following settings:

HoldingTime: Type in “1” to wait one second between sending the next data set.
Port: Select Output Port-Udp, 21000.

RecordCount: Type in “10” to send out the first ten rows of data each time.
Sorts: Apply the following settings:

o FirstSort: Select Last Name (2).

o FirstSortOrder: Select Asc.

o  SecondSort: Select First Name (1).

o  SecondSortOrder: Select Asc.

Appendix A 25



Commands Properties
Command 1 t* B General -
Type Serolling
B Misc
HoldingTime 1
Port Output Port-Udp. 211 _
RecordCount 10 3
B Sorts Sort Setting
FirstSort Last Name(2)
FirstSortOrder  Asc
SecondSort First Name(1) i
Asc

5. Click Ok when finished.

6. Name the function button “Scrolling with Sorting”.

The Function Button Configuration window should now look like this:

Function Button Configuration @
In DDM, each worksheet has 3 designated toolbar, on which you can put a series function buttons. You can define
a list of commands (a script) for each button to run when the button is clicked.

Select the worksheet to configure keys: Properties:
DDM - Range 1 - E Misc
} Mame Scrolling with Sorting

Buttons: Script Command Collection
Stop
Paging
Scroling
Serolling with Sorting

Name

Give the button a descriptive name meaningful for you to

mport ] [ Add ] ’ Remove know what command(s) the button represents.
[ ok ][ Canesl

1. Click Ok when finished.

2. To locate the function buttons, click Add-Ins at the top of the screen in newer versions of
Microsoft Excel, or look in the bottom left corner of Microsoft Excel 2003.

m_ Home Insert Page Layout Formulas

Stop Paging Scrolling Scrolling with Sorting

Custom Toolbars

Data Review

View

Add-Ins

: Stop Paging Scrolling !
Ready
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Creating the ITF

Creating an ITF is not necessary to complete this particular exercise. However, an ITF will be needed
to see how the information would look using a display controller.

Click the ITF Configuration button to open a window to set up an Input Template File.
Select DDM - Range 1 in the Data Stream drop-down box.

Click OK and Save the ITF with an easy to remember name in an easy to remember location,
preferably the same folder as the DDM spreadsheet file or directly in the display controller

program folder.

Refer to the Daktronics display controller software for information on creating display
sequences using Real-Time Data (RTD) fields.

Entering & Sending Data

1.

Type any ten random names into the spreadsheet, with the First Name and Last Name
corresponding to the blue headers.

Note: The column widths may be widened to see the whole names if necessary, but make
sure no name exceeds 25 characters per cell.

A B C D E

DAKTRONICS DATA MANAGER

1
2
3
4
g First Name Last Mame
6 Carl Johnson
7 Dave Smith
8 Sally Jones
9 Heather Miller
10 Joe Grant
11 Stan Walker
12 Beth Thompson
13 Steve Brooks
14 Sherri Philips
15 Am Philips
16 I ]
| ]
7

Click the Paging button to begin sending out the list of o ? ox
names. Since there are ten names and the button is set up to
send five rows at a time, there will be two pages of Port: udp:f255.255.255.255:
information switching back and forth. Watch the Output Timestamp:  6/5/2005 11:32:06 &M
Monitor to see the information appear. First Hame Last Name
Now click the Scrolling button. Each name will appear and g‘a” Walker
X A . eth Thompszan
move up one at a time until the first empty row and then Steve Branks
start over from the top. et Philips
my Fhillips
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Now try clicking the Scrolling with Sorting button. Even
though the names in the spreadsheet are out of order, the
Output Monitor shows that they are now listed
alphabetically. Notice that if two people share the same last
name, the first names are listed in alphabetical order too
because of the SecondSort command.

Click the Stop button to stop sending out data from the
spreadsheet. The Output Monitor will display the last data
set that was successfully sent. It is not necessary to stop
sending out data to modify it. Simply type in the changes
on-the-fly and they will appear in the next data cycle.

gn’ilxl

Pork:

Tirnestamp:

Firzt Mame

udp: /255,255,255, 255;
BI512008 11:36:03 AM

Last Mame

hillips

Phillip
Smith

Thompzan
i alker

Note: For newer versions of Excel, the data monitor window may have a black background

with black text, so it appears as if nothing is outputting:

Output Monitor I x

o

Port: udp://255.255.255.255

10/1/2014 5:23:06 PM

Timestamp:

To confirm that data is in fact being sent out, click and drag on the text in this box:

Output Monitor O 4+ =
Port: udp://255.255.255.255
Timestamp: 10/1/2014 5:28:18 PM

Also, the Timestamp field still notes the time of each successful transmission.
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